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Appendix L: Using the Himalayan Database with Wine

Wine is an open-sourced software application that allows Microsoft Windows

programs to run on Unix-based operating systems such as Linux, Solaris, and
Macintosh OS X (10.6 and higher).

The Himalayan Database is compatible with Wine and Macintosh OS versions
OS X 10.6 (Snow Leopard) through macOS 10.14 (Mojave). Currently the Wine
version of the Himalayan Database is not compatible with macOS 10.15
(Catalina) or later. It is unlikely that Wine will be further developed for
later versions of the macOS.

The Wine version of the Himalayan Database was created by using the freeware
WineBottler application that is based on Wine.

CrossOver 1s a commercial product that is also based on Wine and also can be
used to run the Himalayan Database (see Appendix K). CrossOver is
compatible with macOS 10.15 (Catalina), macOS 11 (Big Sur) and
macOS 12 (Monterey) for Intel Macs.

The primary advantage of using the WineBottler version is that it is very simple
to install and use, and it is freeware. However, there is no support offered by the
WineBottler vendor.

The primary advantage of using CrossOver is that other Windows applications
can be installed and run in conjunction with the Himalayan Database such as
Microsoft Excel for Windows, the Internet Explorer, or other proprietary
programs. CodeWeavers, the CrossOver vendor, also offers extensive support for
it customers.

Further information about using Wine can be found at the following links:
http://fen.wikipedia.org/wiki/Wine (software)

https://[www.winehq.org
http://winebottler.kronenberg.org

Installing and Running the Database with Wine
Download the Himalayan Database Wine folder to your Mac from

www.himalavandatabase.com/himalwine.html

and move it to your Applications folder. If it is downloaded as a “.zip” or “.tar”
archive folder, double click it to expand it.

You may want to create a short-cut for the Himal application and place it on
your desktop, or you may drag the application to your dock.



Launch the Himalayan Database by double-clicking the Himal application file
within the Himalayan Database Wine folder. The first time you launch the

Himal application, the program will initiate the Windows environment, which
may take 10 to 20 seconds or more. Subsequent launches will be much quicker.

You will be asked to accept the software license and terms the first time you run
the program.

The Himalayan Database ]

Software License & Terms of Use

This limited license grants the user of the Himalayan Database
and accompanying documentation the non-exclusive,
non-transferable and perpetual license rights as set forth
herein. Any and all rights not expressly granted herein in the
Himalayan Database are reserved by the Himalayan Database.
Notwithstanding anything to the contrary contained herein, all
rights, title and interest, including, but not limited to,
copyright, trademark and all other intellectual property
rights, to and in the Himalayan Database and any copies or
duplicates thereof, belong solely to the Himalayan Database.

Each licensed copy of the Himalayan Database may either be
used by a single person who uses the software personally on
one or more computers, or installed on a single computer used
simultaneously by multiple people.

You may not copy the Himalayan Database or any portion or part
thereof except for making one back-up copy for archival _vJ

When you want quit the Himalayan Database and exit Wine, first select the Exit
command from the File menu in the Himalayan Database:

® O
Himal Display Search Reports Analyses
About

Setup »

Export »

Update...

Exit CTRL+Q

If you exit Wine directly without first exiting the Himalayan Database, you will
get the following error message.

® O O Visual FoxPro

A Cannot Quit Yisual FoxPro

Click “OK” and then follow the correct sequence described above (you may have
to click “OK” several times).



Printing with Wine

Wine provides its own dialog box for printing from Windows programs.

® Print
~Printer
MName: HP_Laserlet_400_M401dne LI Propetties |
Status: Ready
Type: HP_Laserlet_400_M401dne
Where: CUPS:HP_Laserlet_400_M401dne

Comment: HP LaserJet 400 M401dne

~Print range Copies
& al Mumber of copies: 1 -
" Pages from: |1 to: | 65534 ™ coflate
€| Selection ‘:I" \_jr j’

Cancel |

By default, the printed output will be one-sided. If you want double-sided output,
click on the “Properties” button and then select either “Flip on Long Edge” or
“Flip on Short Edge” depending on whether you are printing in Portrait or
Landscape mode.

@ Setup

Paper I

Paper Size:

[ Orientation

&+ Portrait

" Landscape

Duplex:

OFf -]

OFf

Short-Edge Binding
l  u

QK I Cancel Apply




Printing PDFs with Wine

Printing PDF files from Wine requires the installation of the PDFwriter for Mac
software in your Macintosh OS X system. Double-click the PDFwriter_for_Mac
1.2.1.dmg installer package that is contained inside the Himalayan Database
Wine folder (then double-click on the Lisanet PDFwriter icon and follow the
Instructions).

8 00 « Install Lisanet PDFwriter

Welcome to the Lisanet PDFwriter Installer

@ Introduction

You will be guided through the steps necessary to

® License | :
install this software.

@ Destination Select
@ Installation Type

® Instattation

® Sumgpmary

Go Back | Continue

After the installation is completed, you must add the PDFwriter printer to your
printer list. Select “System Preferences” from the Apple menu and then select
“Printers & Scanners.” Click the “+” box below the printer list and the select
“PDFwriter” from the Add window.

1@ 00 Printers & Scanners
< | > Show All Q
Printers
o HP LaserJet 400 M401dne
CUPS-PDF
=== @ ldle
' HP LaserJet 2420 | Open Print Queue... |

@ In use

| Options & Supplies... |

* Toner low, Default

OKI-C530-D24FD2 Location:
o Idle

Kind: HP Laserjet 400 M401dne
Cranans

Status: Toner low
= CanoScan LiDE 700F

|| Share this printer on the network | Sharing Preferences...

Default printer: | HP LaserJet 400 M401dne >

Default paper size: | US Letter | (?2)




| NON | Add

3@ w .

Default IP  Windows Search
Name ~ Kind
CUPS-PDF cups-pdf
HP LaserJet 400 M401dne (023590) Bonjour

Bonjour

OKI-C530-D24FD2
PDFwriter pdfwriter

Name: PDFwriter

Location:

Use: Generic PostScript Printer

The selected printer software isn’t from the manufacturer and may not
let you use all the features of your printer.

Add

If the Use option only has “Generic Postscript Printer” available instead of
“Lisanet PDFwriter” (which often occurs with the newer versions of OSXs), then

you will need to manually locate the Lisanet printer driver.

Add

3@ w .

Default IP  Windows Search
Name A Kind
CUPS-PDF cups-pdf
HP LaserJet 400 M401dne (023590) Bonjour

Bonjour

OKI-C530-D24FD2
PDFwriter pdfwriter

Name: PDFwriter

Location
Auto Select

Use v Generic PostScript Printer
Select Software...

Add




Click on the Use drop-down list and select the “Other” option to bring up the
following navigation screen:

| < -

'l Favorites Name

. B Recents > Virtual Machines

1 0 Downloads > GraphicConverter
> PDF to Excel Converter

#3; Applications » (] OpticBook4800

. [ Documents > B Stuffit |
> MacKeeper Backups

|

I (5 Desktop > Roxio Web Video Items

| 33 Dropbox » [ Roxio Converted Items

| E HimallScancrr > RDC Connections

!

i Devices -

| Q Annapurna > Roxio Captured Items

| Q Khumb > Anicesoft

ClileC > Microsoft User Data
\
Q Everest > Streamer Videos i

{

’ Q Mustang > Adobe
> My Barnes & Noble eBooks

I [E) pumori . MAee it

| =

Cancel

Click on the “Documents” (or other folder) option at the top of screen and
navigate to the Lisanet printer driver by following the path

Macintosh HD -> Library -> Printers -> Lisanet ->PDFwriter

and click the “Open” button for the PDFwriter.ppd in the PDFwriter folder.

Ed < > 8 E 00 3B5v  @W Printers

i a Q

<>

|
! Favorites Name
| @ Recents
4 Icons
| 0 Downloads S ho
/3 Applications > Lexmark
| @ Documents > Brother |
» [ Samsung
|
| B Desktop v Lisanet
| % Dropbox v [ PDFwriter
| £ Himal Scans
!
Devices writer.pp
Ineed R PDFwriter.ppd
{ Q Annapurna > OKIDATA |
| Q Rl » [ EPSON
ya > Canon
‘ Q Everest > PPDs i
\
| Q Mustang
[ Q Pumori
| =

The Add screen should now show Lisanet PDFwriter as the Use option. Click on
“Add” to add PDFwriter to your list of available printers.



When printing a PDF file from the Himalayan Database, select “PDFwriter”
from the Print dialog.

8 00 Print
~Printer
MName: PDFwriter j Properties
e CLPS_PDF
AWS: Ihn_Laserdet_2420_ BATE46_
Type: HP_Laserlet_400_M401dne
OKI C530 D24FD2
\Where:
Comment: PDFwriter k
~Print range —Copies
& al MNumber of copies: 1 3
' Pages from: |1 ko | 9999

l:l/ \jé ‘j-? ™ collate
oK I Cancel |

€ Selection

The PDF-output is written to the PDFwriter folder in the Users Shared folder
and is given a generic file name such as “job-976-Visual_FoxPro.pdf.”

= Macintosh HD

Users

|l Shared

100 —— _ﬁpdfwriter — .
B - B R oo C—

FAVORITES Name A Date Modified Size K

:: Dropbox v [ ihimalaya Today, 4:16 PM -~ F
- ™. job_976 Visual FoxPro.pdf  Yesterday, 8:46 PM 72KB Al

Coogle Drive

Desktop

ST

ihimalaya

-~
| }
L]

Applications

Documents

o
<]
H
=
o
o
a
w

DEVICES

El

iHimalaya Mac Pro

—
el i
Macintosh HD

[=])
Kathmandu

You can rename your PDF-output file to better match its contents. Also you may
want to create a desktop alias for the shared PDFwriter folder and rename that
alias to “Wine PDFs” or something else to your liking.
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Saving Excel Files with Wine

When saving Excel files (or any other type of file), a recommended practice is to
save them to the Macintosh desktop so that they can be easily accessed. In the
“Save As” dialog box, scroll up from “winebottler” and select “desktop” and then
click the “Save” button after naming your output file.

® O Save As
Save in: I[E winebottler Ll ﬁl @I
| JHIMDATA

Excel file I LI Save I
j Cancel |

Code Page..,

Files of type: IXLS

® O Save As

Save in: I[E, winebottler j ﬁl @l

| JHIMDATA

= My Computer
ﬁ My Documents S
e/
| applications
u_:_‘] himalayan database 2.0 wine

|5 himal 2.0.app
| % contents v

Excel file I Ll Save I
j Cancel |

Code Page...

Files aof type: IXLS
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O @ Save As

Save in: IEDBSHUD j ﬁl QI EI

I JHIMDATA

Excel file I everest ascents| | | Save I
Files aof tvpe: |XLS j Cancel |

If you mistakenly save your Excel file to “winebottler”, you can locate your file by
selecting the Himal application file from the Himalayan Database Wine folder
inside of the Applications folder and issuing a Get Info command (Cmd-I) and
selecting Show Package Contents:

[ NON ) | 7] Himalayan Database Wine
< H = BEERERECE=D | o #- $¥v|  Qsean
Favorites Name ~  Date Modified Size
g Dropbox '@ Appendix G - Reports (Sep 2017) Aug 24, 2017, 2:20 PM 20.5 MB
A Applicati '@ Appendix H - Analyses (Sep 2017) Aug 24, 2017, 2:26 PM 12.7 MB
Fra. 1 Appendix L - Using with Wine (Sep 2017)  Yesterday, 3:50 PM 13.9 MB
[ Desktop [ v Himal o= oday, 3:51 PM 378.4 MB
(3 Documents S Sow Package Contenis —— IASIEMUBARANN
JENY _Show Package Contents Mar 15, 2011, 10:58 AM 259 KB
o SR Readi  Move to Trash Yesterday, 3:54 PM 910 bytes
Devices
. Get Info
[=] iHimalaya M... Rename
Annapurna Compress “Himal 2.0"
Mustang Burn‘ “Himal 2.0" to Disc...
. Duplicate
Pumori Make Alias
Dolpo Quick Look “Himal 2.0”
Lhotse Share >
Tsarang Copy “Himal 2.0"
Nuptse Show View Options
S— Tags...
[E]
2 everest 000000
Dhaulagiri
Ringmo Services >
Kathmandu

Then navigate down to your output file and drag it to the desktop.
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A Himal 2.0

* E o Il =~ & i o  &H- > 29 Q,
Name ~ Date Modified Size
v | | Contents 3:52 PM -
* Info.plist 3:52 PM 2 KB
> [ MacOS 3:52 PM .-
¥ | 7] Resources 3:52 PM --
o Credits.html 3:52 PM 69...ytes
» | | English.lproj 3:52 PM -
Al Icon.icns 3:52 PM 36 KB
Wine.bundle 8/20/17 22..MB
v | | wineprefix 3:52 PM -
» | | dosdevices 3:57 PM --
¥ [ drive_c 3:52 PM --
» | | Program Files 3:52 PM -
» [N users 3:52 PM -
b || windows 3:52 PM .
¥ | | winebottler 9:12 PM -
FOXUSER.DBF 9:05 PM 90...ytes
FOXUSER.FPT 9:12 PM 2 KB
& Himal 2.0.exe 3:52 PM 11.4 MB
b | HIMDATA 3:52 PM --
VFPOR.DLL 3:52 PM 4.7 MB
VFPORENU.DLL 3:52 PM 1.2 MB
& system.reg 3:52 PM 1.2 MB
& user.reg 3:52 PM 65 KB
& userdef.reg 3:52 PM 3 KB
WineBottler.id 3:52 PM 20 bytes
winetricks.log 3:52 PM 6 bytes
& Winetricks 8/20/17 1.1 MB

Saving a report to an Excel file poses a special problem when going cross-
platform from Windows to Macintosh (or vice-versa) due to the fact that Excel for
Windows and Excel for Macintosh use different Julian base dates in date fields.
For Windows, the Julian base date of 1 is Dec 30, 1899 while for Macintosh the
Julian base date of 1 is January 1, 1904 (the two versions occur because they use
differing strategies to account for the fact that 1900 was not a leap year).

Normally, Excel handles this properly if a Windows-export is first opened by
Excel for Windows and a Mac-export is first opened by Excel for Macintosh. Once
opened, the file is properly marked so that date fields in subsequent openings of
the file are properly handled regardless of which version of Excel is used.

But when saving Excel files from a Windows program run under Wine, most
likely you will be first opening the file using Excel for Macintosh. Thus the date
fields may be incorrect (off by 1462 days) unless adjusted for if you are using
default base dates in Microsoft Office 2008 or earlier. The Himalayan Database
allows you to compensate for this by selecting “Macintosh-based Excel Dates” in
the following dialog window that appears when you save the file.
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Set Excel Date Format

This Excel export file contains date fields that
will be formatted for Excel for Macintosh

Specify Windows-based Excel dates only if
this Excelfile is to be INITIALLY opened
with default base dates in Excel for Windows

Macintosh-based Excel Dates (Office 2011 or later v

indows-based Excel Dates
Macintosh-based Excel Dates (Office 2008 or earlier)
Macintosh-based Excel Dates (Office 2011 or later)

Further information about Excel base dates and how to compensate for their
differences may be found by doing a Google search for “Excel base dates.”

Updating the Database
Periodic updates to the Himalayan Database will be issued via the Internet at
www.himalayandatabase.com

These updates will add records for new expeditions and corrections and
additions to records for previous expeditions.

For users running the Himalayan Database with Wine on a Macintosh, the
instructions are similar to those running on Windows except that the location
where the update files are placed can assist in making the update process easier.

First download the compressed update package from the website onto the
desktop of your Macintosh and decompress by double-clicking on the update
package. The result of the decompression is a folder with a name similar to
“Himal Autumn 2019 Updates” containing 14 update files:

expchgs.dbf memchgs.fpt refer.cdx
expchgs.fpt memchgs.cdx peaks.dbf
expchgs.cdx memlog.dbf peaks.fpt
explog.dbf refer.dbf peaks.cdx
memchgs.dbf refer.fpt

The files of the form “exp...” and “mem...” contain the changes to be applied to
the EXPED and MEMBERS tables. The files of the form “refer...” and “peaks...”
are replacement files for the current files in the Himalayan Database.

Note: The Autumn-Winter 2018 Update adds four new fields to the MEMBERS
database MSMTNOTE1, MSMTNOTE2, MSMTNOTES3 and DEATHRTE).
These new fields are only added if you first download and install the Himal 2.2
(or later) version of the database program before applying the update. If you

14



apply the update with an earlier version of the Himal program, the new fields
will not be added. See the section “Replacing Components of the Database” for
instructions for installing a new version of the Himal program.

Start the Himal program and use the Update command in the File menu to
apply the updates to the Himalayan Database.

| NON
Himal Display Search Reports Analyses
About
Setup b
Export b
Exit CTRL+Q

Confirm that you wish to proceed with the update:

x Confirm

0 Do vou wish to update the Himalayan Database?

Yes MNo

The Select Expedition Update File dialog screen will appear:

® @ Select Expedition Update File (expchgs.dbf)

Look in: IBwinebottIer j ﬁl | Eil gl;l

| JHIMDATA
| FOXUSER.DEF

Select expchgs I ;] QK
Files of kype: |Tahle,|'DBF LI Cancel
’;Qle{ F'.ax;]%. +

A
Navigate to the Himal Updates folder, which may appear below “winebottler”:

15



elect Expedition Update File (expchgs.db
@® @ Select Expedition Update File ( hgs.dbf)
Look in: =) winebattler -l o 3| B £[E
— [ winebottler -
I]E iHIMDAT.ﬁ. = B
| Fouuser | L RECYCLEBIN
o | Evistr Audio
BHD Icons
~— Himal Agency (Spr 2016)
& Himal Autumn 2017 Updates
| Himal Staff (Sept 2017)
E Hirmalayan Database -
Select expchgs I EI QK
j Cancel
Code Page...

Files of kype: ITabIe,l'DBF
v

O e
 J—
~ Ju—

or if it not visible, navigate to and select “desktop” above it and then select the

|

Himal Updates folder:
Select Expedition Update File (expchgs.dbf)
- 2| gl B| £

® O
|| Himal Autumn 2017 Updates
F Y

|

Look in:
[ JHIMDATA
= My Computer

—I FASEIRES [ﬁ My Documents
=},
| applications
B himalayan database 2.0 wine
| himal 2.0.app
[E, contents -
Select expchgs I Z| oK
ITabIe,l’DBF ;I Cancel
Code Page

Files of kype:

16




O @® Select Expedition Update File (expchgs.dbf)

Look in: I Deskkop

-l o @ Bl EE

My Documents
$RECYCLE.BIN
~|Evistr Audio
~JHD Icons

I_D Himal Agency (Spr 2016)
:Himal Autumn 2017 Updates
[ JHimal Staff (Sept 2017)

[ JHimalayan Database

—D HIMDATA 16-12-11

l—D HIMDATA 17-07-11 (18)

2

Select expchgs I

| oK

Files of bype: ITabIeIDBF

.

After you have selected and opened the Himal Update folder, select the first file
named “expchgs.dbf” and click the OK button in the dialog box.

© @® Select Expedition Update File (expchgs.dbf)

Look in: |\E Himal Autumn 2017 Updates

= & @ Bl EIE

:| explog.DEF
:| memchgs.DEF
:| rmemlog.DEF
| Peaks.dbf

| Refer.dbF

Select expchgs I expchgs.DEF

Files of type: ITabIe,I'DBF

A

All remaining update files are loaded automatically during the update process.

Confirmation messages are given that each of the four tables—expeditions,
members, literature references, and peaks—has been updated.
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Uninstalling the Database

The Himalayan Database may be uninstalled by deleting both the Himalayan
Database Wine folder (about 450 mb) in the Applications folder and
Himal2x.app_nnnnnnnn folder (about 150 mb) in the Application Support folder
located inside of the Library folder in the Users folder (see illustrations below).

If you are deleting an older version of the Himalayan Database after installing a
newer version, make sure to delete the folders with the oldest dates.

[ BON } 1 Applications
< sBomom = 6 o il o #- 3 Q
Name ~  Date Modified Size Kind
» [ FlipdMac Aug 7, 2015 at 3:06 PM --  Folder
folderol Apr 23, 2015 at 10:12 AM 1.1 MB  Application
@> Foldery Jan 6, 2015 at 8:59 PM 543 KB Application
& Font Book Nov 3, 2019 at 1:38 PM 129 MB  Application
Q' GarageBand Mar 12, 2012 at 11:17 PM 242.8 MB  Application
G Google Chrome Dec 13, 2019 at 10:29 PM 443.5 MB  Application
£ Google Drive Apr 1, 2018 at 2:57 PM 33 bytes  Alias
Q Google Earth Pro Mar 18, 2019 at 8:58 PM 192.1 MB  Application
@ Grammarly Apr 5, 2018 at 5:29 AM 146.2 MB  Application
& Grammarly.dmg Apr 15, 2018 at 3:57 PM 55.6 MB  Disk Image
> GraphicConverter £ Nov 22, 2019 at 9:08 PM --  Folder
» Helium £ Aug 19, 2017 at 3:43 PM -- Folder
» Bl Himalayan Database Wine Nov 29, 2019 at 5:24 PM --  Folder
& HPPrinterDriver2.16.1.dmg Oct 15, 2013 at 1:53 PM 524.1 MB  Disk Image
() iBooks Dec 17, 2019 at 7:57 PM 50.1 MB  Application
o iDVD Jul 19, 2011 at 10:22 PM 103.9 MB  Application
@ Image Capture Nov 3, 2019 at 1:38 PM 2.3 MB Application
B Image Rescue 4 Oct 27, 2009 at 5:48 PM 51MB  Application
K iMovie Nov 22, 2014 at 8:49 PM 1.2GB  Application
& iMovie9.0.9Update.dmg May 14, 2013 at 1:19 PM 1.08 GB  Disk Image
& IntegoUninstaller.dmg May 6, 2010 at 6:31 AM 299 KB  Disk Image
> InTouch Dec 14, 2019 at 3:34 PM --  Folder
> iReal Blu-ray Player £ Jan 27, 2017 at 8:36 PM --  Folder
B iReal Mac Blu-ray Player Jun 20, 2016 at 2:40 AM 98 MB  Application
4 iSkysoft Audio Recorder Dec 27, 2015 at 10:19 PM 21.1 MB  Application
> iSkysoft iMedia Converter Deluxe Nov 21, 2017 at 11:57 AM -- Folder
» iSkysoft PDF Converter Pro (Trial) Sep 26, 2014 at 3:53 AM 52.4 MB  Application
v iSkysoft PDFElement Pro Jun 25, 2019 at 1:35 PM -- Folder
[ NON ] @3 Application Support .
e ] = IERERIGER=D | Lok - 2 B Q
> Name ~  Date Modified size Kind
> » [ Fission Oct 15, 2019 at 3:14 PM -~ Folder
> GarageBand Apr 10, 2012 at 10:37 PM -- Folder
> > Google Dec 9, 2018 at 8:02 PM --  Folder
» » Im Google Earth Oct 27, 2019 at 5:52 PM -~ Folder
> Grammarly Apr 15, 2018 at 3:58 PM -~ Folder
> GraphicConverter Aug 21, 2019 at 4:52 PM -- Folder
> > Helper Nov 7, 2018 at 12:27 AM --  Folder
€ I8 Himal22.app15750555542444 ____________Todayat®02PM_____________._Folder |
> > mHP Oct 24, 2017 at 11:43 PM -~ Folder
B > mmicdd Jul 25, 2017 at 12:12 PM -~ Folder
> iCloud Jul 15, 2017 at 4:16 PM --  Folder
» » miovD Apr 9, 2016 at 1:50 PM -~ Folder
» » [ iLifeMediaBrowser Apr 10, 2012 at 10:35 PM -~ Folder
LS iLifePageLayout Mar 14, 2012 at 10:01 PM --  Folder
< iReal Software Jun 5, 2014 at 7:12 PM --  Folder
» > iskysoft Nov 7, 2018 at 12:27 AM -~ Folder
> iSkysoft Audio Recorder Sep 11, 2014 at 10:59 PM -~ Folder
LB iSkysoft iMedia Converter Deluxe Jul 20, 2017 at 10:17 PM -- Folder
> iSkysoft_iMedia_Converter_Deluxe Apr 21, 2016 at 5:02 PM --  Folder
» > bwiweb Aug 7, 2015 at 2:59 PM -~ Folder
<N Kindle Sep 15, 2019 at 12:03 AM -~ Folder
> Knowledge Nov 3, 2019 at 2:51 PM --  Folder
> Labels & Addresses Jan 14, 2015 at 12:08 AM --  Folder
> » I LaCie Dec 17, 2014 at 8:58 PM -~ Folder
> Launchpad Manager Aug 26, 2019 at 8:18 PM --  Folder
> Mail Apr 9, 2015 at 10:48 AM --  Folder
l > MediaDownloadKit Aug 2, 2015 at 10:49 PM -- Folder
» A +90 2014 2t 1:24 DA Eald

The user Library folder may be directly accessed by from the Apple Go menu
item by holding down the Option key:

18



@ Finder File Edit View M Window Help
Back B[
Forward #]
Enclosing Folder ®T

& Recents - %8F
[ Documents %0
& Desktop %D
© Downloads XL
£t Home 0 %8H
B3 Library
[=] Computer
® AirDrop
@ Network 038K
& iCloud Drive 8l

#X; Applications 08A
3 utilities

>

i dc]
8K

Recent Folders

Go to Folder...
Connect to Server...
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